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1. Related Manuals 
 
The table below lists the manuals that relate to this document.  

To ensure system safety, make sure to always read and heed the information provided in all 

Safety Precautions, Precautions for Safe Use, and Precaution for Correct Use of manuals for 

each device which is used in the system. 

 

Cat.No. Model Manual Name 

W500 NJ501-[][][][] 

NJ301-[][][][] 

NJ-series CPU Unit Hardware User's Manual 

W501 NJ501-[][][][] 

NJ301-[][][][] 

NJ-series CPU Unit Software User's Manual 

W497 CJ1W-DRM21 CJ-series DeviceNet™ Units Operation Manual for 

NJ-series CPU Unit 

W267 - DeviceNet™ Operation Manual 

W504 SYSMAC-SE2[][][] Sysmac Studio Version 1 Operation Manual 

W464 - CX-Integrator Ver.2 Network Configuration Tool 

Operation Manual 

I578 3G3RX-V1-[][][][][]-V1 RX Series Type V1 High-function General-purpose 

Inverter User's Manual 

I581 3G3AX-RX-DRT-E MX2/RX Series DeviceNet Communications Unit User's 

Manual 

 

 

2. Terms and Definitions 
 

Term Explanation and Definition 

Master/Slave A master is a unit that controls the DeviceNet communications.  

A master sends output data to multiple slaves and receives input data from 

the slaves.  

Slaves receive output data that are sent from the master, and send input 

data to the master.  

At least one master is required for DeviceNet communications.  

EDS file An EDS file is a file that contains the I/O points of DeviceNet slave units 

and the parameters that can be set via DeviceNet. 

Node address 

(MAC ID) 

A node address is an address to identify a unit connected to a DeviceNet 

network. With DeviceNet, a MAC (Media Access Control) ID is used as a 

node address. Thus, a node address is a MAC ID.  

Scan list A scan list is used to register slaves with which a master communicates in 

DeviceNet remote I/O communications. A master communicates with the 

slaves based on the scan list settings.  
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3. Remarks 
 

(1) Understand the specifications of devices which are used in the system. Allow some 

margin for ratings and performance. Provide safety measures, such as installing safety 

circuit in order to ensure safety and minimize risks of abnormal occurrence.  

(2) To ensure system safety, always read and heed the information provided in all Safety 

Precautions, Precautions for Safe Use, and Precaution for Correct Use of manuals for 

each device used in the system.  

(3) The user is encouraged to confirm the standards and regulations that the system must 

conform to.  

(4) It is prohibited to copy, to reproduce, and to distribute a part of or whole part of this 

document without the permission of OMRON Corporation.  

(5) The information contained in this document is current as of January 2013. It is subject to 

change without notice for improvement. 

 



3．Remarks 

The following notation is used in this document.  

  

 

Indicates a potentially hazardous situation which, if not avoided, 
will result in minor or moderate injury, or may result in serious 
injury or death. Additionally there may be significant property 
damage. 

 
Indicates a potentially hazardous situation which, if not avoided, 
may result in minor or moderate injury or in property damage. 

 

Precautions for Safe Use 

Precautions on what to do and what not to do to ensure safe usage of the product. 

 

 

Application precautions  

Precautions on what to do and what not to do to ensure proper operation and performance. 

 

Additional Information  
Additional information to read as required.  

This information is provided to increase understanding or make operation easier. 
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4. Overview 
 

This document describes the procedure for connecting the Inverter (3G3RX-V1 series) of 

OMRON Corporation (hereinafter referred to as OMRON) to the NJ-series Machine 

Automation Controller (hereinafter referred to as the Controller) via DeviceNet and provides 

the procedure for checking their connection. 

Specifically, it describes the procedure for connecting DeviceNet using DeviceNet settings of 

the project files prepared beforehand (hereinafter referred to as the "procedure for using the 

configuration files").  

Section 9 A-1 and Section 10 A-2 describe the procedures for setting parameters without the 

prepared configuration files (hereinafter referred to as the "procedure for setting parameters 

from the beginning").  

 

To follow the "procedure for using the configuration files", prepare the latest "Sysmac Studio 

project file" and "CX-Integrator project file" (they are referred to as "configuration files") from 

OMRON in advance.  

 
Name File name Version 

Sysmac Studio project file 
(extension: SMC) 

OMRON_3G3RX-V1_DN_EV100.SMC Ver.1.00 

CX-Integrator project file 
(extension: cin) 

OMRON_3G3RX-V1_DN_EV100.cin Ver.1.00 
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5. Applicable Products and Support Software 
 

5.1. Applicable Products 

The applicable devices are as follows: 

 

Manufacturer Name Model Version 

OMRON NJ-series CPU Units 
NJ501-[][][][] 
NJ301-[][][][] 

OMRON DeviceNet Unit (Master) CJ1W-DRM21 
OMRON Inverter 3G3RX -[][][][][]-V1 
OMRON DeviceNet Communications 

Unit 
3G3AX-RX-DRT-E 

Versions listed in 
Section 5.2 or higher 
versions 

 

Precautions for Correct Use  

As applicable devices above, the devices with the models and versions listed in Section 5.2. 

are actually used in this document to describe the procedure for connecting devices and 

checking the connection.  

You cannot use devices with versions lower than the versions listed in Section 5.2.  

To use the above devices with versions not listed in Section 5.2 or versions higher than those 

listed in Section 5.2, check the differences in the specifications by referring to the manuals 

before operating the devices.  

 

Additional Information  
This document describes the procedure to establish the network connection. Except for the 

connection procedure, it does not provide information on operation, installation or wiring 

method. It also does not describe the functionality or operation of the devices. Refer to the 

manuals or contact your OMRON representative. 
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5.2. Device Configuration 

The hardware components to reproduce the connection procedure of this document are as 

follows: 

 

 

 

 

 

 

 

 

 

DeviceNet cable 

3G3RX-A2055-V1 + 
3G3AX-RX-DRT-E NJ501-1500+ 

CJ1W-DRM21

 

Personal computer 
(Sysmac Studio 
installed, 
OS: Windows7) 

USB cable 

T-branch Tap (DCN1-1C) 

Manufact

urer 

Name Model Version 

OMRON DeviceNet Unit (Master) CJ1W-DRM21 Ver.1.1 

OMRON CPU Unit NJ501-1500 Ver.1.03 
OMRON Power Supply Unit NJ-PA3001  
OMRON DeviceNet cable DCA1-5C10  
OMRON T-branch Tap DCN1-1C  
OMRON Sysmac Studio SYSMAC-SE2[][][] Ver.1.04 

OMRON CX-Integrator (Included with Sysmac Studio) Ver.2.55 

OMRON Sysmac Studio project file OMRON_3G3RX-V1_DN_EV1
00.SMC 

Ver.1.00 

OMRON CX-Integrator project file OMRON_3G3RX-V1_DN_EV1
00.cin 

Ver.1.00 

- Personal computer  
(OS: Windows 7) 

-  

- USB cable 
(USB 2.0 type B connector) 

-  

OMRON Inverter 3G3RX -A2055-V1  
OMRON DeviceNet Communications 

Unit 
3G3AX-RX-DRT-E  
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5．Applicable Products and Support Software 

 

Precautions for Correct Use  

To use the configuration files, prepare the latest "Sysmac Studio project file" and 

"CX-Integrator project file" in advance.  

(To obtain the files, contact your OMRON representative.) 

 

Precautions for Correct Use  

Update the Sysmac Studio to the version specified in this section or higher version using the 

auto update function.  

If a version not specified in this section is used, the procedures described in Section 7 and 

subsequent sections may not be applicable. In that case, use the equivalent procedures 

described in the Sysmac Studio Version 1 Operation Manual (Cat.No. W504).  

 

Additional Information  
For information on the DeviceNet cable and network wiring, refer to Chapter 2 Network 

Configuration and Wiring of the DeviceNet Operation Manual (Cat. No. W267).  

Connect a terminating resistance to each end of the trunk line of the DeviceNet.  

 

Additional Information  
In this document, a USB is used to connect with the Controller. For information on how to 

install a USB driver, refer to A-1 Driver Installation for Direct USB Cable Connection of the 

Sysmac Studio Version 1 Operation Manual (Cat.No. W504).  
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6. DeviceNet Settings 
 

This section provides the specifications such as communications parameters and variables 

that are defined in this document.  

Hereinafter, the Inverter is referred to as the "destination device" in some descriptions.  

 

 

6.1. DeviceNet Communications Settings 

The DeviceNet settings are shown below. 

 

 DeviceNet Unit Inverter 

Unit number 0 - 

Node address (MAC ID) 63 0 

Baud rate (bps) 500 kbps (Automatically follows the Master Unit) 

Remote I/O - 1 (Extended Speed I/O) 
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6.2. Allocation for Remote I/O Communications 

The remote I/O communications data of the destination device are allocated to the Controller's 

global variables. An allocation for the remote I/O communications data is called a scan list. 

The relationship between the device data and the global variables is shown below.  

The following global variables are defined in the "configuration file". 

 

■Output area (Controller → Inverter) 

Offset 

Destination device 

data 

Memory used for 

CJ-series Unit 

Global variable 

name 

Data type 

+0 Command %3200 DN00_CMD_OUT BOOL[16] 

+1 Rotation Speed 

Reference 
%3201 DN00_DATA_OUT 

WORD 

 

■Input area (Controller ← Inverter) 

Offset 

Destination device 

data 

Memory used for 

CJ-series Unit 

Global variable 

name 

Data type 

+0 Status information %3300 DN00_STA_IN BOOL[16] 

+1 Rotation Speed 

Monitor 
%3301 DN00_DATA_IN WORD 

 

Additional Information  
For details on I/O format, refer to Section 4 Remote I/O in the MX2/RX Series DeviceNet 

Communication Unit User's Manual (Cat. No. I581). 

 

Additional Information  
When a DeviceNet Unit is used with a Controller, slave data are allocated to the memory 

used for CJ-series Units. With programs, specify variable names for the memory used for 

CJ-series Units.  

With Sysmac Studio, add the prefix "%" to each address to indicate the memory used for 

CJ-series Units.  
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■Details on output area 

Global variable Name Meaning 
DN00_CMD_OUT[0] FW Forward/stop 0: Stop, 1: Forward 
DN00_CMD_OUT[1] RV Reverse/Stop 0: Stop, 1: Reverse 
DN00_CMD_OUT[2] RS Fault reset 0:-, 1: Fault reset 

DN00_CMD_OUT[5] CTR Net Ctrl. 
0: Follow the setting of parameter A002. 
1: Follow the reference from network control. 

DN00_CMD_OUT[6] REF Net Ref. 
0: Follow the setting of parameter A001. 
1: Follow the reference from network control. 

DN00_DATA_OUT 
Rotation Speed 
Reference 

If parameter P049 (Number of Poles for Rotation 
Speed Setting) is set appropriately, the rotational 
speed unit is [min -1]. 
If parameter P049 (Number of Poles for Rotation 
Speed Setting) is set to 0, the frequency unit is [0.01 
Hz]. 

 

 

■Details on input area 

Global variable Name Meaning 

DN00_STA_IN[0] AL 
Alarm 
output 

0:Normal, 1: Fault/Trip 

DN00_STA_IN[1] WR Warning 0: Normal, 1: Warning 

DN00_STA_IN[2] FWR 
During 
forward 
operation 

0: During reverse run/Stopping, 1: During forward run 

DN00_STA_IN[3] RVR 
During 
reverse 
operation 

0: During forward run/Stopping, 1: During reverse run 

DN00_STA_IN[4] IRDY 
Operation 
ready  

0: Not ready, 1: Ready 

DN00_STA_IN[5] CFN 
Ctrl.From 
Net 

0: Follow the setting of parameter A002. 
1: DeviceNet reference 

DN00_STA_IN[6] RFN 
Ref.From 
Net 

0: Follow the setting of parameter A001. 
1: DeviceNet reference 

DN00_STA_IN[7] FA1 
Constant 
speed 
reached 

0: Accelerating or decelerating/Stopping, 1: Frequency 
agree 

DN00_STA_IN [15] to [11] [10] [9] [8] 
1: Startup 0 0 0 1 
2: Not ready 0 0 1 0 
3: Ready 0 0 1 1 
4: Operation in 
progress 

0 1 0 0 

5: Stopping 0 1 0 1 
6: Fault/Trip stop 0 1 1 0 

DN00_STA_IN[8] 
to  

DN00_STA_IN[15] 

Drive Status 
  

7: Fault/Trip 0 1 1 1 

DN00_DATA_IN 
Rotation Speed 
Reference 

If parameter P049 (Number of Poles for Rotation Speed 
Setting) is set appropriately, the rotational speed unit is 
[min -1]. 
If parameter P049 (Number of Poles for Rotation Speed 
Setting) is set to 0, the frequency is monitored in units of 
[0.01 Hz]. 
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7. Connection Procedure 
 

This section describes the procedure for connecting the Controller to Inverter via DeviceNet 

using the "procedure for using the configuration files". 

This document explains the procedures for setting up the Controller and Inverter from the 

factory default setting. For the initialization, refer to Section 8 Initialization Method. 

 

 

Personal computer 
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Destination 

device 

Controller 

7.1. Overview of Setting up Remote I/O Communications 

The following figure shows the relationship of processes to perform DeviceNet remote I/O 

communications using the "procedure for using the configuration files". 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Opening  
project file 

Sysmac Studio project file CX-Integrator project file 

Importing  
project file 

Toolbox 

Transferring 
scan list 

CX-Integrator Sysmac Studio 

Transferring 
project data 

 

 

Precautions for Correct Use  

Prepare the latest "Sysmac Studio project file" and "CX-Integrator project file" from OMRON 

in advance.  

(To obtain the file, contact your OMRON representative.) 
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7.2. Work Flow 

Take the following steps to make connection settings for remote I/O communications of 

DeviceNet.  

 

7.3. Setting Up the Inverter Set up the Inverter.  

↓  

 7.3.1 Hardware Setting Mount the DeviceNet Communications Unit on the 

Inverter.  

↓  

 7.3.2 Parameter Setting Set the parameters for the Inverter.  

↓  

7.4. Setting up the Controller Set up the Controller.  

↓  

 7.4.1 Hardware Setting for DeviceNet 

Unit 

Set the hardware switches on the DeviceNet Unit 

and connect to the Controller. 

↓  

 7.4.2. Starting the Sysmac Studio and 

Importing the Project File 

Start the Sysmac Studio and import the Sysmac 

Studio project file. 

↓  

 7.4.3 Connecting Online and 

Transferring the Project Data 

Connect online with the Sysmac Studio and transfer 

the project data to the Controller. 

↓  

7.5 Setting Up the Network Set up remote I/O communications of DeviceNet.  

↓  

 7.5.1. Starting the CX-Integrator and 

Opening the Project File 

Start the CX-Integrator and open the CX-Integrator 

project file. 

↓  

 7.5.2. Connecting Online and 

Transferring a Scan List 

Connect online with the Controller, and transfer the 

setting (scan list) of the set device to the DeviceNet 

Unit via the Controller.  

↓  

7.6. Connection Status Check Check the connection status of the DeviceNet 

network. 

↓  

 7.6.1. Checking the Connection Status Confirm that the DeviceNet communications is 

normally performed.  

↓  

 7.6.2. Checking Data that are Sent 

and Received 

Confirm that the correct data are sent and received.
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7.3. Setting Up the Inverter 

Set up the Inverter. 

 

7.3.1. Hardware Setting 
Mount the DeviceNet Communications Unit on the Inverter. 

 

Precautions for Correct Use  

Make sure that the power supply is OFF when you perform the settings.  

 

1 Check the name of each part on 
the Inverter and the DeviceNet 
Communications Unit by 
referring to the right figure. 

●Inverter 
 
 

●DeviceNet Communications Unit 

A. Inverter connection PCB 
B. LED indicators (MS and NS) 
C. Flat cable 
D. DeviceNet connector 
E. Grounding cable 
F. Housing 

A. Digital Operator 
B. Spacer cover 
C. Terminal cover 
D. Front cover 
E. Operator connector
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7．Connection Procedure 

2 Mount the DeviceNet 
Communications Unit on the 
Inverter. 
 
*For the mounting procedure of 

the DeviceNet Communications 

Unit, refer to 2-2-2 Mounting 

Procedure of DeviceNet 

Communications Unit on 

RX-series Inverter in the 

MX2/RX Series DeviceNet 

Communication Unit User's 

Manual (Cat. No. I581).  

3 Connect the power supply to the 
main power supply input 
terminal. 
  
 
*The location of the power 
supply input terminal differs 
depending on the model. 
Refer to 2-3-4 Wiring for Main 
Circuit Terminals in the RX 
Series Type V1 High-function 
General-purpose Inverter 
User's Manual (Cat. No. I578). 
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7.3.2. Parameter Setting 
Set the parameter (node address) for the Inverter.  

 

Additional Information  
Make sure that DeviceNet is not connected when you perform the setting up.  

 

1 Turn ON the power supply to the 

Inverter.  

 

*Set the parameter by using the 

Digital Operator on the front of 

the Inverter.  

 

Data display 
Displays the frequency reference value, 
output current value or set value, or other 
relevant data. 

 
RUN key 

Runs the Inverter. This key is enabled 
when RUN Command Selection is set to 
Digital Operator. 
(Check that the RUN command LED 
indicator is lit.) 

 
STOP/RESET 
key 

Decelerates to stop the inverter. This key is 
used to reset an error when an error is 
occurring in the Inverter. 

 
Mode key 

Switches between Monitor Mode (d [][][]), 
Basic Function Mode (F000) and Extended 
Function Mode (A [][][], b[][][], C[][][], H[][][]).

 
Enter key 

Enters the set value. 
(Make sure to press this key when you 
change the set value.) 

 
Increment Key

Switches each mode. 
This Key is also used to increment the set 
value of each function. 

 
Decrement 
Key 

Switches each mode. 
This Key is also used to decrement the set 
value of each function.  

Operation keys

RUN command LED indicator 

Data display
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7．Connection Procedure 

2 
 

When you turn ON the power 

supply, the display shows data 

as shown on the right.  

Set the parameters by using the 

procedure on the right.  

 

[A001] Frequency Reference 

Selection 1: 05 

[A002] RUN Command 

Selection 1: 05 

 

*Set 05 (Option 2).  

 

00.00 
             

a001 

             

a002 

               

05 

             

a001 

             

a002 

               

02 

             

a005 

             

a002 

Press the Increment Key three times. 

Press the Enter Key. 

Press the Increment Key once. 

Parameter A002 is displayed.

The parameter is displayed again. 

Press the Enter Key. 

The data is changed to 05. 

The default data is displayed. 

The parameter is displayed again.

Press the Enter Key. 

The data is changed to 05. 

Press the Increment Key three times. 

The default data is displayed.

Press the Enter Key. 

Press the Mode Key three times.

Parameter A001 is displayed.

(By default, the display shows the data of 

d001 (Output Frequency Monitor).) 

After turning ON the power 
supply, the display shows data.
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7．Connection Procedure 

3 Set the parameter by using the 

procedure on the right. 

 

[C102] Reset selection: 03 

 

*Set 03 (Trip reset only). By 

setting this value, the 

communications connection is 

not reset even if the Inverter is 

reset. 

a002 
             

c001 

             

c102 

             

02 

             

03 

             

c102 
The parameter is displayed again.

Press the Enter Key. 

The data is changed to 03. 

Press the Increment Key once. 

Press the Enter Key. 

The default data is displayed. 

Parameter C102 is displayed.

Press the Increment Key and display 

C102. 

Parameter C001 is displayed.

Press the Mode Key twice. 

The parameter is displayed. 
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4 Check the parameter by using 

the procedure on the right. 

 

[P046] Assembly Instance 

Number 

: 1 (Default value: Extended 

Speed I/O) 

 

*Confirm that the default value 

(1: Extended Speed I/O) is set.

c102 
             

p001 

             

p046 

             

 1 

             

p046 

5 Set the parameter by using the 

procedure on the right. 

 

[P192] DeviceNet MAC ID: 00 

 

*Set the node address to 00. 

p046 
             

p192 

             

63 

            

The parameter is displayed. 

Press the Mode Key twice. 

Parameter P001 is displayed.

Press the Increment Key to display 

P046. 

Parameter P046 is displayed.

Press the Enter Key. 

The default data is displayed. 

Press the Enter Key. 

The parameter is displayed again.

 

00 

             

p192 

Press the Enter Key. 

The parameter is displayed again. 

The data is changed to 00. 

Press the Decrement Key. 

The default data is displayed. 

Press the Enter Key. 

Parameter P192 is displayed.

to display P192. 

Press the Increment Key 

The parameter is displayed. 

 18



7．Connection Procedure 

6 Turn OFF the power supply to 

the Inverter.  

 

Connect the DeviceNet cable.  

 

Cycle the power supply to the 

Inverter.  

 

*To to enable the changes 

described above, make sure to 

cycle the power supply to the 

Inverter. 

DeviceNet cable 

 

T-branch Tap 
(DCN1-1C) 
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7．Connection Procedure 

 

7.4. Setting Up the Controller 

Set up the Controller.  

 

7.4.1. Hardware Setting for DeviceNet Unit 
Set the hardware switches on the DeviceNet Unit and connect to the Controller.  

 

Precautions for Correct Use  

Make sure that the power supply is OFF when you perform the setting up.  

 

1 Make sure that the power supply 
to the Controller is OFF.  
 
*If the power supply is turned 
ON, settings may not be 
applicable as described in the 
following procedure. 

 

 

2 Check the hardware switches on 
the front panel of the DeviceNet 
Unit by referring to the right 
figure. 

3 Set the Unit No. Switch to 0.  

 

Setting method: One-digit hexadecimal 

Setting range: 0 to F 

Note: The unit number is set to 0 at the factory. 

4 Set the Node Address Switches 
to 63.  

 
Setting method: Two-digit decimal 

Setting range: 0 to 63 

Note: The node address is set to 63 at the factory. 
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7．Connection Procedure 

5 Set pin 2 of the DIP switch to 
ON. (Set pins 1, 3 and 4 of the 
DIP switch to OFF.) 
 
*The baud rate is set to 500 
kbps.  

All pins are set to OFF at the factory. 

6 Connect the Controller to the 
DeviceNet Unit.  
Connect the personal computer, 
Inverter and Controller using the 
DeviceNet cable and USB cable 
as shown in 5.2 Device 
Configuration. 
Turn ON the power supply to the 
Controller and DeviceNet. 

 

DeviceNet 
cable 

CJ1W-DRM21 

USB cable 

NJ501-1500

End Cover

Power Supply Unit
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7．Connection Procedure 

 

7.4.2. Starting the Sysmac Studio and Importing the Project File 
Start the Sysmac Studio, and import the Sysmac Studio project file.  

Install the Sysmac Studio and USB driver in the personal computer beforehand.  

 

1 Start the Sysmac Studio.  

Click the Import Button.  

 

*If a confirmation dialog for an 

access right is displayed at 

start, select to start.  

 

 

2 The Import File Dialog Box is 

displayed. Select 

OMRON_3G3RX-V1_DN_EV10

0.SMC (Sysmac Studio project 

file) and click the Open Button. 

 

*Obtain the Sysmac Studio 

project file from OMRON.  

3 OMRON_3G3RX-V1_DN_V100 

project is displayed.  

The left pane is called Multiview 

Explorer, the right pane is called 

Toolbox and the middle pane is 

called Edit Pane.  

 

*If an error dialog box is 

displayed, check the version of 

the Sysmac Studio. 

 

Edit Pane Edit Pane ToolboxMultiview 

Explorer 
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7．Connection Procedure 

4 Double-click CPU/Expansion 

Racks under Configurations 

and Setup in the Multiview 

Explorer, and select the 

DeviceNet Unit.  

Confirm that CJ1W-DRM21 is 

displayed and the unit number is 

0 as shown in the right figure. 

 

5 Select Check All Programs 
from the Project Menu.  

 

6 The Build Tab Page is displayed 

in the Edit Pane.  

Confirm that "0 Errors" and "0 

Warnings" are displayed.  

 

7 Select Rebuild Controller from 
the Project Menu.  

 

8 Confirm that "0 Errors" and "0 

Warnings" are displayed in the 

Build Tab Page.  
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7．Connection Procedure 

 

7.4.3. Connecting Online and Transferring the Project Data 
Connect online with the Sysmac Studio and transfer the project data to the Controller. 

 

 

 
Always confirm safety at the destination node before you transfer a user 

program, configuration data, setup data, device variables, or values in memory 

used for CJ-series Units from the Sysmac Studio.  

The devices or machines may perform unexpected operation regardless of the 

operating mode of the CPU Unit.  

 

 

Always confirm safety before you reset the Controller or any components.  

 

 

1 Select Change Device from the 

Controller Menu.  

 

2 The Change Device Dialog Box 

is displayed.  

Confirm that Device and Version 

are set.  

 

*If the settings are incorrect, 

select the setting items from the 

pull-down list.  

 

Click the OK Button.  
 

3 If the setting is changed in step 

2, the Build Dialog Box is 

displayed. Click the Yes Button.

 

 24



7．Connection Procedure 

4 Select Communications Setup 
from the Controller Menu.  

 

5 The Communications Setup 

Dialog Box is displayed.  

Select the Direct connection via 

USB Option in the Connection 

Type Field.  

 

Click the OK Button.  

6 Select Online from the 

Controller Menu.  

 

 

*If the dialog on the right is 

displayed, the model or version 

of the Controller does not 

match that of the project file. 

Check the model and version of 

the Controller and the device 

settings of the project file, 

return to step 1 and try again. 

Click the OK Button to close the 

dialog box.  
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7 A confirmation dialog box is 

displayed. Click the Yes Button. 

 

*The displayed dialog depends 

on the status of the Controller 

used. Click the Yes Button to 

proceed with the processing.  

 

*The displayed serial ID differs 

depending on the device.  

 

 

 
 

Additional Information  
Refer to Section 5 Online Connections to a Controller in the Sysmac Studio Version 1 

Operation Manual (Cat. No. W504) for details on online connections to a Controller.  

 

8 When an online connection is 

established, a yellow bar is 

displayed on the top of the Edit 

Pane.  

9 Select Synchronization from 

the Controller Menu.  

 

10 The Synchronization Dialog Box 

is displayed.  

Confirm that the data to transfer 

(NJ501 in the right figure) is 

selected. Then, click the 

Transfer to Controller Button. 
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11 A confirmation dialog is 

displayed. Click the Yes Button. 

 

A screen stating "Synchronizing" 

is displayed.  

 

A confirmation dialog box is 

displayed. Click the Yes Button.

 
 

 

 

12 Confirm that the synchronized 

data is displayed with the color 

specified by "Synchronized" and 

that a message is displayed 

stating "The synchronization 

process successfully finished". 

  

If there is no problem, click the 

Close Button.  

 

*If the synchronization fails, 

check the wiring and try again 

from step 1. 

 

 

13 Select Reset Controller from 

the Controller Menu.  

 

*When Mode is set to RUN 

Mode, Reset Controller cannot 

be selected. In this case, select 

Mode - PROGRAM Mode from 

the Controller Menu to change 

to PROGRAM mode and follow 

the procedure in this step.  
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14 A confirmation dialog box is 

displayed several times. Click 

the Yes Button.  

 

15 The Controller is reset, and 

Sysmac Studio goes offline.  

The yellow bar on the top of the 

Edit Pane disappears.  

Use steps 6 to 8 to go online. 
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7.5. Setting Up the Network 

Set up remote I/O communications of DeviceNet. 

 

7.5.1. Starting the CX-Integrator and Opening the Project File 
Start the CX-Integrator and open the CX-Integrator project file. 

 

1 Start the CX-Integrator. 

 

*If the Component List Window 

is not displayed, select 

Windows - Component List 

Window from the View Menu.  

 

 

2 

Select Open from the File Menu.

 

3 The Open Dialog Box is 

displayed. Select 

OMRON_3G3RX-V1_DN_EV10

0.cin (CX-Integrator project file) 

and click the Open Button. 

4 The following devices are 

displayed in the Network 

Configuration Pane as shown on 

the right figure. 

#63: CJ1W-DRM21 
#00: 3G3AX-RX-DRT- A2055 

  

Component List Window 

Network Configuration Window

Output window 
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Precautions for Correct Use  

Please confirm that the DeviceNet cable is connected before proceeding to the following 

procedures.  

If it is not connected, turn OFF the power to the devices, and then connect the DeviceNet 

cable.  
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7.5.2. Connecting Online and Transferring the Scan List 
Connect online with the Controller, and transfer the setting (scan list) of the device 

configuration to the DeviceNet Unit via the Controller. When the transfer is completed, 

remote I/O communications start automatically.  

 

1 Select Auto Online from the 

Network Menu.  

2 The Auto Online Dialog Box is 

displayed. Select the USB 

connection Option in the 

Connection type Field, and click 

the Connect Button.  

 

3 After an online connection is 

established, the background 

color of the Network 

Configuration Window changes 

as shown in the right figure.  

 
 

Precautions for Correct Use  

If an online connection cannot be made to the Controller, check the cable connection. Or, 

return to step 1, check the settings such as a connection type and try again.  

 

Additional Information  

For details on the online connections to a Controller, refer to Section 2 Basic Operations in 

the Communications of the CX-Integrator Ver.2.[] Operation Manual (Cat. No. W446).  
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7．Connection Procedure 

 
 

4 Right-click DeviceNet in the 

Online Connection Information 

Window, and select Connect.  

5 Select DeviceNet in the Select 

Network Dialog Box, and click 

the OK Button.  

 

6 Confirm that the DeviceNet is in 

online status ( icon) in the 
Online Connection Information 
Window. 

 

7 Right-click CJ1W-DRM21 on the 
Network Configuration Window, 
and select Parameter - Edit. 

8 The Edit Device Parameters 

Dialog Box is displayed. Click 

the Download Button.  
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9 A download confirmation dialog 

box is displayed. Click the Yes 

Button to download the 

parameters.  

10 A dialog box is displayed 

confirming whether to change 

the mode. Click the Yes Button. 

 

 

 

 

 

A dialog box is displayed 

indicating downloading is being 

performed.  

 

 

 

 

When downloading is 

completed, a dialog box is 

displayed confirming whether to 

change the mode. Click the Yes 

Button.  
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11 The Edit Device Parameters 

Dialog Box is displayed again. 

Click the Compare Button.  

 

12 A dialog box shown on the right 

is displayed. Click the Yes 

Button to compare the 

parameters.  

 

 

 

 

 

 

 

 

When the comparison is 

completed, a dialog box shown 

on the right is displayed. Click 

the OK Button. 

 

 

 

 

 

 

The Edit Device Parameters 

Dialog Box is displayed again. 

Click the OK Button. 
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7.6. Connection Status Check 

Check the connection status of the DeviceNet network. 

 

7.6.1. Checking the Connection Status 
Confirm that the DeviceNet communications is working.  

 

1 Confirm that the DeviceNet 

communications is performed 

normally by checking the LED 

indicators on each unit.  

•DeviceNet Unit 

LED indicators in normal status  

MS: Lit green 

NS: Lit green 

During normal operation, the 

7-segment display shows 63. (63: 

Master node address, remote I/O 

communications active and 

normal) 

 

 

 

•Inverter 

LED indicators in normal status  

MS: Lit green 

NS: Lit green 

 

 

 (DeviceNet Unit) 

 

 
(Inverter) 
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2 Confirm that the DeviceNet 

communications are performed 

normally from the CX-Integrator by 

referring to the status information on 

the Monitor Device Dialog Box.  

 
Right-click the master icon on the 
Network Configuration Window, and 
select Monitor.  

3 The figure on the right shows the 
Status Tab Page of the Monitor 
Device Dialog Box. 
 
DeviceNet communications are 
normally performed if the same 
items are selected in the Master 
Status Field, #00 is lit blue in the 
Slave Status Field, and the Remote 
I/O Communications Running 
Check Box is selected.  
 
Click the Close Button.  

(Monitor Device Dialog Box) 

4 Go offline with the CX-Integrator.  
Select Work Online from the 
Network Menu.  
 

*The  icon is not pressed during 
offline connection.  
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7.6.2. Checking Data That Are Sent and Received 
Confirm that the correct data are sent and received.  

 

 

 
Always confirm safety at the destination node before you transfer a user 

program, configuration data, setup data, device variables, or values in memory 

used for CJ-series Units from the Sysmac Studio.  

The devices or machines may perform unexpected operation regardless of the 

operating mode of the CPU Unit.  

 

 
The Inverter will run if you proceed to this section. Confirm safety before 

operation. If you cannot confirm safety, do not proceed to this section after 

completing until Section 7.6.1.  

If you proceed to this section, make sure to complete all the steps and place the 

Inverter in the safe state. 

 

 

1 Select Watch Tab Page from the 

View Menu.  

 

2 The Watch Tab Page 1 is displayed 

in the lower section of the Edit 

Pane. 

 

3 The following names are entered in 

the Watch Tab Page for monitoring. 
DN00_STA_IN[5] 
DN00_STA_IN[6] 
DN00_CMD_OUT[0] 
DN00_DATA_OUT 

  

4 Set the display format as follows: 
DN00_STA_IN[5]: [Boolean] 
DN00_STA_IN[6]: [Boolean] 
DN00_CMD_OUT[0]: [Boolean] 
DN00_DATA_OUT: [Decimal] 
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5 Confirm that the online values of 
DN00_STA_IN[5] and 
DN00_STA_IN[6] are True. 
 
*DN00_STA_IN[5]: CFN 

0: Follow the setting of 
parameter A002.  

1: DeviceNet reference  
*DN00_STA_IN[6]: RFN 

0: Follow the setting of 
parameter A001.  

1: DeviceNet reference 

 

6 Enter 100 in the Modify Column of 
DN00_DATA_OUT. 
 

*[DN00_DATA_OUT: Rotation 

Speed Reference] 

The unit of the rotation speed is 

0.01 Hz. 
 
After entering values, press the 

Enter key on the keyboard. The 

online value is changed to 100. 

 

 

 

7 Confirm that RUN LED indicator of 

the Inverter is not lit and 0.00 is 
shown on the data display (Output 
frequency setting). 

8 Click True in the Modify Column of 

DN00_CMD_OUT[0].  

 
*DN00_CMD_OUT[0]: FW 
0: Stop/1: Forward 

 

 

The online value changes to True. 

 
 

 

 0.00 
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9 Confirm that RUN LED indicator of 

the Inverter is lit and 1.00 is 
shown on the data display (Output 
frequency). 

10 Click FALSE in the Modify Column 

of DN00_CMD_OUT[0]. 
 
The online value changes to False. 

11 Confirm that 0.00 is shown on the 
data display (Output frequency) on 
the front of the Inverter again and 
that the RUN LED indicator is not lit.

 1.00 

 0.00 
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8. Initialization Method 
 

This document explains the setting procedure from the factory default setting. 

Some settings may not be applicable as described in this document unless you use the 

devices with the factory default setting. 

 

8.1. Controller 

To initialize the Controller, it is necessary to initialize the CPU Unit and DeviceNet Unit. 

Change to the PROGRAM mode before initialization. 

 

8.1.1. DeviceNet Unit 
To initialize the settings of the DeviceNet Unit, select Edit Special Unit Settings of 

CJ1W-DRM21 in CPU/Expansion Racks from the Sysmac Studio.  

Select Clears the scan list from the Scan List Clear Switch. 

 
 

Click the Apply Button and the Transfer to Controller Button. 
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8.1.2. CPU Unit 
To initialize the settings of the Controller, select Clear All Memory from the Controller 

Menu of the Sysmac Studio.  

 

 

 

 

8.2. Inverter 

For the initialization of the Inverter, refer to Initialization Setting of 5-1-2 Parameter 

Initialization in the RX Series Type V1 High-function General-purpose Inverter User's Manual 

(Cat. No. I578). 
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9. Appendix 1 Details on Remote I/O Communication Settings 
 

This section explains the details on the settings necessary to perform remote I/O 

communications of DeviceNet that is set in this document.  

 

9.1. Global Variable Table 

The Controller accesses the remote I/O communications data as global variables. The 

settings of the global variables are shown below. Use the Sysmac Studio to register a global 

variable table. 

 

Name Data type AT Destination device allocation 

DN00_CMD_OUT BOOL[16] %3200 Command 

DN00_DATA_OUT WORD %3201 Rotation Speed Reference 

DN00_STA_IN BOOL[16] %3300 Status information 

DN00_DATA_IN WORD %3301 Rotation Speed Monitor 

 

Additional Information  
Set the AT to the values in memory used for CJ-series Units, which were allocated to the 
slaves using the CX-Integrator. With the Sysmac Studio, add the prefix "%" to each address 
to indicate the memory used for CJ-series Units. To allocate a bit address, set the data type 
to BOOL and set the AT to %3200.00 as shown below.  

Name Data type AT Destination device allocation 
DN00_OUT_Bit00 BOOL %3200.00 Bit 00 Output 

:    
DN00_OUT_Bit15 BOOL %3200.15 Bit 15 Output 
DN00_IN_Bit00 BOOL %3300.00 Bit 00 Input 

:    

 

DN00_IN_Bit15 BOOL %3300.15 Bit 15 Input 

  

Do not specify the same area for the bit and word addresses as shown below.  

Name Data type AT Destination device allocation 
DN00_OUT_Bit00 BOOL %3200.00 Bit 00 Output 

:    
DN00_OUT_Bit15 BOOL %3200.15 Bit 15 Output 

 

DN00_OUT WORD %3200 Bits 00 to 15 Output (2 bytes) 
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9．Appendix 1 Details on Remote I/O Communication Settings 

 

Additional Information  
With the Sysmac Studio, the data type is expressed as ARRAY[0..2] OF WORD when an 
array is specified for a data type. However, a data type of an array is simplified in this 
document. (e.g. WORD[3]).  
You can set either of the following to specify an array for a data type with the Sysmac Studio. 

•ARRAY[0..2] OF WORD 
•WORD[3] 

In the example above, 3 WORD array elements are secured. 
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10. Appendix 2 Setting Procedure without the Configuration Files
 

This section describes the procedure for setting up the Controller using the software without 

using the configuration files (Procedure for setting the parameters from the beginning).  

You can also refer to this section when you change the parameters of the configuration files.  

 

Personal computer 
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Destination 

device 

Controller 

10.1. Overview of Setting Procedure without the Configuration Files 

The following figure shows the relationship of processes to perform remote I/O 

communications using the "procedure for setting parameters from the beginning". 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Settings made with Sysmac Studio 
•Setting parameters (DeviceNet 
Unit) 

•Setting global variables (name and 
AT, etc) 

•Building 
•Settings in the Watch Tab Page 

Settings made with 
CX-Integrator 

•Create the network 
configuration 

•Setting device (creating scan 
list) 

CX-Integrator 

Transferring 
project data 

Sysmac Studio 

Transferring 
scan list 



10．Appendix 2 Setting Procedure without the Configuration Files 

 

10.2. Work Flow of the "Procedure for Setting Parameters from the Beginning" 

The following is the procedure for making connection settings for remote I/O communications 

of the DeviceNet using the "procedure for setting parameters from the beginning". 

This section describes the detailed procedures for "10.3 Setting up the Controller without the 

Configuration Files" and "10.4 Setting up the Network by CX-Integrator" (in red frames below) 

to make settings with software without using "configuration files". 

For details on the procedures for 7.3 Setting the Inverter, 7.4.1 Hardware Setting for the 

DeviceNet Master Unit, and 7.6 Checking the Connection Status, refer to Section 7 because 

they are the same as the "procedure for using the configuration files". 

 

7.3 Setting Up the Inverter Set up the Inverter. 
↓  

 7.3.1. Hardware Setting Mount the DeviceNet Communications Unit on the 
Inverter. 

↓  
 7.3.2. Parameter Setting Set the parameters for the Inverter. 

↓  
10.3. Setting Up the Controller Using 

the Software 
Set up the Controller using the software.  

↓  
 7.4.1 Hardware Setting for the 

DeviceNet Unit 
Set the hardware switches on the DeviceNet Unit 
and connect to the Controller.  

↓  
 10.3.2. Starting the Sysmac Studio and 

Setting Parameters for the 
Controller 

Start the Sysmac Studio and set the parameters for 
the Controller.  

↓  
 10.3.3. Setting Global Variables Set global variables used for the remote I/O 

communications.  
↓  

 10.3.4. Connecting Online and 
Transferring the Project Data 

Connect online with the Sysmac Studio and transfer 
the project data to the Controller.  

↓  
 10.3.5. Settings in Watch Tab Page Make settings in the Watch Tab Page to check data 

that are sent and received.  
↓  
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10.4. Setting up the Network by 
CX-Integrator 

Set up remote I/O communications of DeviceNet. 

↓  
 10.4.1 Start the CX-Integrator and 

Creating Network Configuration
Start the CX-Integrator and configure the network 
and device offline. 

↓  
 10.4.2. Setting the Device Set the device and register it in the DeviceNet Unit 

(create a scan list). 
↓  

 10.4.3 Connecting Online and 
Transferring the Scan List 

Connect online with the Controller, and transfer the 
setting (scan list) of the set device to the DeviceNet 
Unit via the Controller.  

↓  
7.6. Connection Status Check Check the connection status of the DeviceNet 

network. 
↓  

 7.6.1 Checking the Connection Status Confirm that the DeviceNet communications is 
normally performed.  

↓  
 7.6.2 Checking Data that are Sent and 

Received 
Confirm that the correct data are sent and received.
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10.3. Setting Up the Controller without the Configuration Files 

Set up the Controller using the software.  

 

10.3.2. Starting the Sysmac Studio and Setting the Parameters for the 
Controller 
Start the Sysmac Studio and set the parameters for the Controller.  

 

1 Start the Sysmac Studio.  

Click the New Project Button. 

 

*If a dialog box is displayed at 

start confirming the access 

right, select an option to start. 

 

2 The Project Properties Dialog 
Box is displayed.  
*In this document, New Project 
is set as the project name.  

 
Confirm the Category and 
Device you use are set in the 
Select Device Field. 
 
Select version 1.03 from the 
pull-down list of Version. 
*Although 1.03 is selected in this 
document, select a version you 
actually use.  

 
 

 

3 Click the Create Button.  
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4 The New Project is displayed.  

The left pane is called Multiview 

Explorer, the right pane is called 

Toolbox and the middle pane is 

called Edit Pane.  

5 Double-click CPU/Expansion 

Racks under Configurations 

and Setup in the Multiview 

Explorer.  

The CPU/Expansion Racks Tab 

is displayed on the Edit Pane. 

 

6 Select Communications under 

Category in the Toolbox.  

 

Select CJ1W-DRM21.  

 

 

Right-click the CJ1W-DRM21 to 

display a menu. 

Select Insert from the menu. 

 

CJ1W-DRM21 is displayed on 

the CPU/Expansion Racks as 

shown in the figure on the right. 

    

 

Multiview 
Explorer 
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7 Enter 0 in the Unit No. Field.  
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10.3.3. Setting the Global Variables 
Set global variables used for the remote I/O communications.  

 

1 Double-click Global Variables 

under Programming - Data in 

the Multiview Explorer.  

 

2 The Global Variables Tab Page 
is displayed in the Edit Pane.  
Click a column under Name to 
enter a new variable.  
 
Enter DN00_CMD_OUT in the 
Name Column.  
 
Enter BOOL[16] in the Data 
Type Column.  
*After entering, ARRAY[0..15] 
OF BOOL is displayed as 
shown on the right figure. 

 
Enter %3200 in the AT Column. 

 

 

 

 

3 After entering values, right-click 

and select Create New from the 

menu.  
 

4 Enter the following data in the 
new columns in the same way 
as step 2. 

•Name: DN00_DATA_OUT 
Data type: WORD 
AT: %3201 

5 Enter the following data in the 
new columns in the same way 
as steps 2 and 3.  

•  Name: DN00_STA_IN
OOL[16] Data type: B

AT: %3300 
• _IN Name: DN00_DATA

ORD Data type: W
AT: %3301 
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10.3.4. Connecting Online and Transferring the Project Data 
Connect online with the Sysmac Studio and transfer the project data to the Controller. After 

transfer, reset the Controller.  

 

 

 
Always confirm safety at the destination node before you transfer a user 

program, configuration data, setup data, device variables, or values in memory 

used for CJ-series Units from the Sysmac Studio.  

The devices or machines may perform unexpected operation regardless of the 

operating mode of the CPU Unit.  

 

 

Always confirm safety before you reset the Controller or any components.  

 

 

1 Select Check All Programs 
from the Project Menu.  

 

2 The Build Tab Page is displayed 

in the Edit Pane.  

Confirm that "0 Errors" and "0 

Warnings" are displayed.  

3 Select Rebuild Controller from 
the Project Menu.  

 

4 Confirm that "0 Errors" and "0 

Warnings" are displayed in the 

Build Tab Page.  
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5 Select Communications Setup 

from the Controller Menu.  

 

6 The Communications Setup 

Dialog Box is displayed.  

Select the Direct connection via 

USB Option in the Connection 

Type Field.  

 

Click the OK Button.  

7 Select Online from the 

Controller Menu.  

A confirmation dialog is 

displayed. Click the Yes Button. 

 

*The displayed dialog depends 

on the status of the Controller 

used. Click the Yes Button to 

proceed with the processing.  

 

 

8 When an online connection is 

established, a yellow bar is 

displayed on the top of the Edit 

Pane.  
 

Additional Information  
For details on the online connections to a Controller, refer to Section 5 Going Online with a 

Controller in the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).  

 

9 Select Synchronization from 

the Controller Menu.  
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10 The Synchronization Dialog Box 
is displayed.  
Confirm that the data to transfer 
(NJ501 in the right figure) is 
selected, and click the Transfer 
to Controller Button. 

11 A confirmation dialog is 
displayed. Click the Yes Button.
 
 
 
 
A screen stating "Synchronizing" 
is displayed.  
 
 
 
 
 
 
 
 
 
 
A confirmation dialog box is 
displayed. Click the No Button. 

 

 

12 Confirm that the synchronized 

data is displayed with the color 

specified by "Synchronized" 

color, and that a message is 

displayed stating "The 

synchronization process 

successfully finished". 

  

If there is no problem, click the 

Close Button.  

 

*If the synchronization fails, 

check the wiring and repeat the 

procedure described in this 

section.  

 

 53



10．Appendix 2 Setting Procedure without the Configuration Files 

13 Select Reset Controller from 

the Controller Menu.  

 

*When Mode is set to RUN 

Mode, Reset Controller cannot 

be selected. In this case, select 

Mode - PROGRAM Mode from 

the Controller Menu to change 

to PROGRAM mode and 

perform the procedure in this 

step.  

 

 

14 A confirmation dialog box is 

displayed. Click the Yes Button.

 

15 The controller is reset, and 

Sysmac Studio goes offline. 

The yellow bar on the top of the 

Edit Pane disappears.  

Use steps 7 to 9 to go online.  
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10.3.5. Settings in the Watch Tab Page 
Make settings in the Watch Tab Page to check data that are sent and received.  

 

1 Select Watch Tab Page from the 

View Menu.  

 

2 The Watch Tab Page 1 is displayed 

in the lower section of the Edit 

Pane. 

3 Enter the following names to 
monitor in the Name Column on the 
Watch Tab Page 1. To enter a new 
name, click a column stating Input 
Name.  

DN00_STA_IN[5] 
DN00_STA_IN[6] 
DN00_CMD_OUT[0] 
DN00_DATA_OUT 

 
 
*The settings are used in 7.6.2. 
Checking Data That Are Sent and 
Received. 
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10.4. Setting Up the Network by CX-Integrator 

Set up remote I/O communications of the DeviceNet by CX-Integrator. 

 

10.4.1. Starting CX-Integrator and Configuring the Network 
Start the CX-Integrator and configure the network and device offline. 

 

Precautions for Correct Use  

Please confirm that the DeviceNet cable is connected before proceeding to the following 

procedures.  

If it is not connected, turn OFF the power to the devices, and then connect the DeviceNet 

cable.  

 

1 Start the CX-Integrator.  

 

*If the Component List Window 

is not displayed, select 

Windows - Component List 

Window from the View Menu. 

 

2 Select Network from the Insert 

Menu of the CX-Integrator.  

 

3 Select DeviceNet and click the 
Next Button.  

Component List Window 

Output window 

Network Configuration Window
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4 Select the Not Used Check Box 
in the Network Address Field 
and click the Finish Button.  

5 Register the Master Unit in the 
Network.  
Select Component from the 
Insert Menu.  

 

6 Select the Master Unit from the 
component list and click the 
Finish Button.  
Here, select OMRON 
Corporation - 
Communications Adapter - 
CJ1W-DRM21.  

7 Enter the node address (63 is 
entered here) in the Node 
Address Setup Dialog Box, and 
click the OK Button.  

 

8 Confirm that the Master Unit is 
registered in the Network 
Configuration Window.  
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9 Register the Inverter (hereinafter 
referred to as the Slave Unit) in 
the network.  
Select Component from the 
Insert Menu.   

10 Select the Slave Unit to connect 
from the component list, and 
click the Finish Button.  
Here, select 
3G3AX-RX-DRT-A2055. 

11 Enter the node address (0 is 
entered here) in the Node 
Address Setup Dialog Box, and 
click the OK Button.  

 

12 Confirm that the Slave Unit is 
registered in the Network 
Configuration Window.  
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10.4.2. Setting the Device 
Set the device and register it in the Master Unit (create a scan list).  

 

1 Right-click the master icon and 
select Parameter - Edit.  

2 The Edit Device Parameters 
Dialog Box is displayed.  
Slave Unit (#00) is displayed in 
the Unregister Device List.  
 
 
 
 
Select the Auto allocation as is 
registered Check Box.  
Click the ↓ button.  
 
 
 
 
Slave Unit (#00) is registered in 
the Unregister Device List.  
 
Confirm that the sizes and 
channels are set as follows, and 
click the OK Button.  
  OUT Size: 4 Byte 
  Out Ch: 3200:Bit00 
  In Size: 4 Byte 
  In Ch: 3300:Bit00 
 

 
 

 

3 Confirm that node address #63 
is displayed under the slave unit 
icon on the Network 
Configuration Window.  
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10.4.3. Connecting Online and Transferring the Scan List 
Connect online with the Controller, and transfer the setting (scan list) of the set device to 

the DeviceNet Unit via the Controller. When the transfer is completed, remote I/O 

communications start automatically.  

 

1 Select Auto Online from the 

Network Menu.  

2 The Auto Online Dialog Box is 

displayed. Select the USB 

connection Option in the 

Connection type Field, and click 

the Connect Button.  

 

A screen is displayed indicating 

the connection is being 

established.  

 

3 After an online connection is 

established, the background 

color of the Network 

Configuration Window changes 

as shown in the right figure. 

 
 

Precautions for Correct Use  

If an online connection cannot be made to the Controller, check the cable connection. Or, 

return to step 1 and check the settings such as a connection type and try again.  

 

Additional Information  

For details on the online connections to a Controller, refer to Section 2 Basic Operations in 

the Communications of the CX-Integrator Ver.2.[] Operation Manual (Cat. No. W446).  
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4 Right-click DeviceNet in the 

Online Connection Information 

Window, and select Connect.  

5 Select DeviceNet in the Select 

Network Dialog Box, and click 

the OK Button.  

 

6 Confirm that the DeviceNet is in 

online status (  icon) in the 
Online Connection Information 
Window.  

 

7 Right-click CJ1W-DRM21 on the 
Network Configuration Window, 
and select Parameter - Edit.  

8 The Edit Device Parameters 

Dialog Box is displayed. Click 

the Download Button.  
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9 A download confirmation dialog 

box is displayed. Click the Yes 

Button to download the 

parameters.  

10 A dialog box is displayed 

confirming whether to change 

the mode. Click the Yes Button. 

 

 

 

 

 

A dialog box is displayed 

indicating downloading is being 

performed.  

 

 

 

 

When downloading is 

completed, a dialog box is 

displayed confirming whether to 

change the mode. Click the Yes 

Button.  
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10．Appendix 2 Setting Procedure without the Configuration Files 

11 The Edit Device Parameters 

Dialog Box is displayed again. 

Click the Compare Button.  

 

12 A dialog box shown on the right 

is displayed. Click the Yes 

Button to compare the 

parameters.  

 

 

 

 

 

 

 

 

When the comparison is 

completed, a dialog box shown 

on the right is displayed. Click 

the OK Button.  

 

 

 

 

 

 

The Edit Device Parameters 

Dialog Box is displayed again. 

Click the OK Button. 
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Revision 

code 

Date of revision Revision reason and revision page 

01 Mar. 5, 2013 First edition 

   

   

 



2013

                    0911(-)P546-E1-01


	1. Related Manuals
	2. Terms and Definitions
	3. Remarks
	4. Overview
	5. Applicable Products and Support Software
	5.1. Applicable Products
	5.2. Device Configuration

	6. DeviceNet Settings
	6.1. DeviceNet Communications Settings
	6.2. Allocation for Remote I/O Communications

	7. Connection Procedure
	7.1. Overview of Setting up Remote I/O Communications
	7.2. Work Flow
	7.3. Setting Up the Inverter
	7.3.1. Hardware Setting
	7.3.2. Parameter Setting

	7.4. Setting Up the Controller
	7.4.1. Hardware Setting for DeviceNet Unit
	7.4.2. Starting the Sysmac Studio and Importing the Project File
	7.4.3. Connecting Online and Transferring the Project Data

	7.5. Setting Up the Network
	7.5.1. Starting the CX-Integrator and Opening the Project File
	7.5.2. Connecting Online and Transferring the Scan List

	7.6. Connection Status Check
	7.6.1. Checking the Connection Status
	7.6.2. Checking Data That Are Sent and Received


	8. Initialization Method
	8.1. Controller
	8.1.1. DeviceNet Unit
	8.1.2. CPU Unit

	8.2. Inverter

	9. Appendix 1 Details on Remote I/O Communication Settings
	9.1. Global Variable Table

	10. Appendix 2 Setting Procedure without the Configuration Files
	10.1. Overview of Setting Procedure without the Configuration Files
	10.2. Work Flow of the "Procedure for Setting Parameters from the Beginning"
	10.3. Setting Up the Controller without the Configuration Files
	10.3.2. Starting the Sysmac Studio and Setting the Parameters for the Controller
	10.3.3. Setting the Global Variables
	10.3.4. Connecting Online and Transferring the Project Data
	10.3.5. Settings in the Watch Tab Page

	10.4. Setting Up the Network by CX-Integrator
	10.4.1. Starting CX-Integrator and Configuring the Network
	10.4.2. Setting the Device
	10.4.3. Connecting Online and Transferring the Scan List


	11. Revision History



